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Software License

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY
USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS
OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE,
PROMPTLY RETURN THE UNUSED SOFTWARE TO THE PLACE WHERE YOU
OBTAINED IT AND YOUR MONEY WILL BE REFUNDED.
1. License. The application, demonstration, system and other software accompanying this License whether on disk, in read only memory, or on any other media
(the “Software”) the related documentation and fonts are licensed to you by Magic
Teleprompting, Inc. You own the disk on which the Software and fonts are recorded
but Magic Teleprompting, Inc. and/or Magic Teleprompting, Inc’s Licensers retain
title to the Software, related documentation and fonts. This License allows you to
use the Software and fonts on a single Apple computer and make one copy of the
Software and fonts in machine-readable form for backup purposes only. You must
reproduce on such copy the Magic Teleprompting, Inc. copyright notice and any
other proprietary legends that were on the original copy of the Software and fonts.
You may also transfer all your license rights in the Software and fonts, the backup
copy of the Software and fonts, the related documentation and a copy of this License
to another party, provided the other party reads and agrees to accept the terms and
conditions of this License.
As regards MagicScroll™ (The Program) specifically, exclusive of ancillary files &
software provided on the program disc, you may (l) use the program on more than
one computer at a time but only one computer at a time can be used to scroll videotext, (2) make copies of the program in machine-readable form solely for backup
purposes, provided that you reproduce all proprietary notices on the copy, (3) physically transfer the program from one computer to another, provided that the scrolling version of the program is used on only one computer at a time, and (4) transfer
the program onto a hard disk only for use as desribed above, provided that you can
immediately prove ownership of the original disks.
2. Restrictions. The Software contains copyrighted material, trade secrets and other
proprietary material. In order to protect them, and except as permitted by applicable legislation, you may not decompile, reverse engineer, disassemble or otherwise
reduce the Software to a human-perceivable form. You may not modify, network,
rent, lease, ban, distribute or create derivative works based upon the Software in
whole or in part. You may not electronically transmit the Software from one computer to another or over a network.
3. Termination. This License is effective until terminated. You may terminate this
License at any time by destroying the Software, related documentation and fonts
and all copies thereof. This License will terminate immediately without notice from
Magic Teleprompting, Inc. if you fail to comply with any provision of this License.
Upon termination you must destroy the Software, related documentation and fonts
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and all copies thereof.
4. Export Law Assurances. You agree and certify that neither the Software nor any
other technical data received from Magic Teleprompting, Inc., nor the direct product thereof, will be exported outside the United States except as authorized and as
permitted by the laws and regulations of the United States. If the Software has been
rightfully obtained by you outside of the United States, you agree that you will not re
export the Software nor any other technical data received from Magic Teleprompting,
Inc., nor the direct product thereof, except as permitted by the laws and regulations
of the United States and the laws and regulations of the jurisdiction in which you
obtained the Software.
5. Government End Users. If you are acquiring the Software and fonts on behalf of any
unit or agency of the United States Government, the following provisions apply. The
Government agrees:
(i) if the Software and fonts are supplied to the Department of Defense (DoD),
the Software and fonts are classified as “Commercial Computer Software” and the
Government is acquiring only “restricted rights” in the Software, its documentation
and fonts as that term is defined in Clause 252.227-7013(c)(1 ) of the DFARS; and
(ii) if the Software and fonts are supplied to any unit or agency of the United States
Government other than DoD, the Government’s rights in the Software, its documentation and fonts will be as defined in Clause 52.227-19(c)(2) of the FAR or, in the case
of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR.
6. Limited Warranty on Media. Magic Teleprompting, Inc. warrants the diskettes and/
or compact disc on which the Software and fonts are recorded to be free from defects
in materials and workmanship under normal use for a period of ninety (90) days
from the date of purchase as evidenced by a copy of the receipt. Magic Teleprompting,
Inc.’s entire liability and your exclusive remedy will be replacement of the diskettes
and/or compact disc not meeting Magic Teleprompting, Inc.’s limited warranty and
which is returned to Magic Teleprompting, Inc. or a Magic Teleprompting, Inc. authorized representative with a copy of the receipt. Magic Teleprompting, Inc. will have
no responsibility to replace a disk/disc damaged by accident, abuse or misapplication. ANY IMPLIED WARRANTIES ON THE DISKETTES AND/OR COMPACT DISC,
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90)
DAYS FROM THE DATE OF DELIVERY. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY
JURISDICTION.
7. Disclaimer of Warranty on Apple Software. You expressly acknowledge and agree
that use of the Software and fonts is at your sole risk. The Software, related documentation and fonts are provided “AS IS” and without warranty of any kind and
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Magic Teleprompting, Inc. and Magic Teleprompting, Inc.’s Licensor(s) (for the purposes of provisions 7 and 8, Magic Teleprompting, Inc. and Magic Teleprompting,
Inc.’s Licensor(s) shall be collectively referred to as “Magic Teleprompting, Inc.”)
EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. MAGIC TELEPROMPTING, INC.
DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE
WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS
IN THE SOFTWARE AND THE FONTS WILL BE CORRECTED. FURTHERMORE,
MAGIC TELEPROMPTING, INC. DOES NOT WARRANT OR MAKE ANY
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF
THE SOFTWARE AND FONTS OR RELATED DOCUMENTATION IN TERMS OF
THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL
OR WRITTEN INFORMATION OR ADVICE GIVEN BY MAGIC TELEPROMPTING,
INC. OR A MAGIC TELEPROMPTING, INC. AUTHORIZED REPRESENTATIVE
SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF
THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND
NOT MAGIC TELEPROMPTING, INC. OR A MAGIC TELEPROMPTING, INC.
AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU.
8. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING
NEGLIGENCE, SHALL MAGIC TELEPROMPTING, INC. BE LIABLE FOR ANY
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES THAT RESULT
FROM THE USE OR INABILITY TO USE THE SOFTWARE OR RELATED
DOCUMENTATION, EVEN IF MAGIC TELEPROMPTING, INC. OR A MAGIC
TELEPROMPTING, INC. AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT
ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY
NOT APPLY TO YOU. In no event shall Magic Teleprompting, Inc.’s total liability to
you for all damages, losses, and causes of action (whether in contract, tort (including negligence) or otherwise) exceed the amount paid by you for the Software and
fonts.
9. Controlling Law and Severability. This License shall be governed by and construed in accordance with the laws of the United States and the State of California,
as applied to agreements entered into and to be performed entirely within
California between California residents. If for any reason a court of competent jurisdiction finds any provision of this License, or portion thereof, to be unenforceable,
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that provision of the License shall be enforced to the maximum extent permissible so
as to effect the intent of the parties, and the remainder of this License shall continue
in full force and effect.
10. Complete Agreement. This License constitutes the entire agreement between the
parties with respect to the use of the Software, the related documentation and fonts,
and supersedes all prior or contemporaneous understandings or agreements, written or oral, regarding such subject matter. No amendment to or modification of this
License will be binding unless in writing and signed by a duly authorized representative of Magic Teleprompting, Inc..
Your purchase of MagicScroll allows you to receive certain product updates,
enhancements and announcements. You are also elligable for technical support.
Magic Teleprompting, Inc.
1390 Waller St.
San Francisco, CA 94117
MagicScroll for Macintosh Tech Support: 415-626-5283
Sales: 800-646-6244
Fax: 415-626-2762
info@magicscroll.com
www.magicscroll.com
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Forward by the designer

Let me introduce myself. I’m Japji (Jop-gee) Singh Khalsa, the designer
of MagicScroll. I’ve been working in the film/video business for over 30
years. The last twenty of those years has been spent growing the largest teleprompting rental business in Northern California, called Magic
Teleprompting, Inc.

oll
MagicScr
Rocks!

Japji Khalsa
President, Magic
Teleprompting, Inc.

Teleprompting has come a long way in those twenty years. When I
first started, paper scroll systems were the most anyone could expect from
a teleprompter. However, computer based prompters slowly made their way
into the market as the technology advanced and the prices came down.
Pretty soon, the DOS world was saturated with programs-- all of them touting different features and different prices. Unfortunately, prompting on the
Macintosh® was a slightly different story. Around the time of the introduction of the Mac Plus, a couple of people tried to write a prompting program
for the Mac. It was feature filled, but it lacked two essential elements of a
prompter. It didn’t provide NTSC composite output to allow interfacing
with the thru-the-lens display unit, and most importantly, it didn’t scroll
smoothly. Fortunately, technology eventually caught up with imagination in
the form of MagicScroll Version 1, introduced in 1991.
Choosing to write a program for the Mac was no small task, especially considering the preponderance of inexpensive DOS based systems.
I thought my experience in the business and my years of teleprompting
allowed me to design a program from the ground up. A program that
wouldn’t be just a glorified word processor, but one that would cater to the
special needs of teleprompting. I wanted to write a great prompting program. I believe MagicScroll is just that. It provides a suite of prompting
tools that are practical, powerful and graceful but not overly-ambitious.
With practice and experimenting, these tools can allow a novice to move
quickly into the realm of great prompting.
Since the introduction of Version 1, MagicScroll has continuously
evolved as we moved through versions 2, 3, 4 and now the introduction of
MagicScroll Version 5 for Mac OS X, designed for the latest versions of both
the Macintosh line of computers and the Mac operating system.
Integrating customer feedback, and our own experience using
MagicScroll in our rental business, we have selectively added features while
increasing performance and ease-of-use. A novice with basic Mac skills
Continued next page...
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can still easily operate MagicScroll, while a more dedicated professional will
find new functionality that will help him/her achieve excellence in the field of
teleprompting.
Version 5 faced many technical challenges to create the best prompting
solution for users of Apple’s Mac OS X. We’ve met those challenges, and now
have a solid, simple-to-use, powerful solution for Macintosh that works on
legacy G4/G5 computers and on the next generation of Intel™ powered computers.
Most of MagicScroll’s features will go unnoticed by the producers and
directors who expect the teleprompter to “just work”. But you, as an operator/
owner, will know that great teleprompting can and does happen. I hope that
MagicScroll helps you achieve that greatness.
Thank you for choosing MagicScroll as your prompting software solution.
Japji Khalsa
President, Magic Teleprompting, Inc.
P.S. To help guide you towards great teleprompting, I’ve included
a section in this manual on teleprompting tips– not just on how to use
MagicScroll, but tips on teleprompting in general that have come from my
years in the business.



About MagicScroll

MagicScroll Rocks!

We are pleased you have chosen MagicScroll™. We believe you will
find it indispensable as a teleproduction tool that will make you and
your talent look good.
MagicScroll is the premier professional teleprompting system available for the Macintosh. It enables your Macintosh computer to scroll
videotext smoothly on a teleprompter. MagicScroll will output to your
NTSC compatible thru-the-lens or podium prompter display.
The features of MagicScroll include:
1) Fonts- the ability to set your script in any Font and Size that is
installed on your Macintosh, as well as to mix and match fonts. Also,
FontSets allow you to create “style sheets” consisting of a Font, Size
and Margins.
2) Colors-the ability to use different colors in your script.
3) Find and Find/Replace- helps you find places in your script and
make changes to words or phrases.
4) Bookmarks- allow instant locating of pre-defined sections of your
script. Bookmarks can be named and saved with your document.
5) Paperclips- allow instant marking of points in your script while
scrolling. Up to 128 paperclips can be placed and saved with your file.
6) Script Queue- allows automated “linking” from the end of one file/
script to the beginning of the next file in the “queue.”
7) Timer- a built in stopwatch for timing rehearsals or takes.
8) An “On Screen” NTSC (Preview) window- allows the operator to see
exactly what is being output to the prompter monitors.
9) Loops- lets the text continually cycle between two defined book
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marks.
10) Blanking Switch- to set your NTSC monitor quickly to black for
stage blackouts.
11) Inverse Video- switches your output text from white on black to
black on white.
12) Graphic Control Window- performs the actual smooth scrolling of
your text through the Mouse or Trackball ADB device. Almost all of the
features of MagicScroll are located on the controller window, allowing
quick access to MagicScroll’s features.
13) Moveable Pointer- a choice of four moveable pointers helps the talent and the operator keep their places in the script.
15) Reverse horizontal/vertical scan- allows you to reverse the output
image while still viewing a non-reversed image on your computer.
This manual will help you get the most out of MagicScroll. MagicScroll
was designed to be as easy to use as possible. That’s why we selected
the Macintosh as a platform. The first section provides step-by-step
instructions for installing MagicScroll. Be sure to read this carefully.

Be sure to read the Read Me! file located on the USB product disk. It
will reflect any changes in the installation and operation of MagicScroll
and may save you some time. The rest of the manual provides instructions for operating MagicScroll: how to load FontSets, set bookmarks,
scroll forward and backward, load search combinations, troubleshooting, reference, and a glossary.
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Installation

Quick Installation
If you are an experienced Macintosh user and don’t like to read manuals, here’s
what you need to get started. If you don’t consider yourself an experienced user, you
might want to skip ahead to the step-by-step instructions.
1. Attach the USB Application drive to a compatible Macintosh Computer.
MagicScroll version 5.0 requires Mac OS X v.10.3.9 or later to operate.
2. Copy the MagicScroll Folder to your Applications folder..
3. The USB device must remain attached to your computer to operate
MagicScroll. If it is not, MagicScroll will only run in Demo mode, and you’ll be
unable to scroll text.
4. Start MagicScroll by double-clicking its icon in the MagicScroll folder.
5. Configure the video output card by selecting the “Video Output...” submenu
under the Preferences item in the File menu. Select the monitor that you want to
use for NTSC output. Click OK.
6. If you want to remove the USB drive, you must “Eject” it in the finder.
7. Have fun using MagicScroll! If you encounter problems, refer to the manual.
Should you need to phone in for assistance, please check the appropriate section
of the manual before calling.

Step-by-step installation
The following is a step-by-step guide to installing the MagicScroll software and
hardware. Again, be sure to read the “Read Me” file, as it will have any changes to
the following instructions.
Before you install MagicScroll, read this section to make sure that you have the
equipment, software, and basic Macintosh skills you need in order to work with
MagicScroll and this manual.
In order to work with MagicScroll, you need:
• A G3, G4, G5 or Intel Macintosh computer meeting the operating system
requirements for Mac OS X v10.3.9 or later
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• At least 20 megabytes free on your hard disk.
• An NTSC composite video monitor to connect to your video card and provide
the image of the smooth scrolling script to the operator and/or the talent.
• Mac OS X v10.3.9 or later
You might also find it helpful to own:
•A word-processing application, such as Microsoft Word..
Before you continue with the instructions in this manual, make sure that:
•You know how to perform basic Macintosh tasks. For example,, you should know
how to select icons, text, and other objects by clicking, double-clicking, and dragging;
how to move, resize, and scroll the contents of windows; how to choose commands
from menus and respond to alerts and dialog boxes; and how to create and name new
folders, copy and name files and disks, and do other work in the Finder™.
If you don’t know how to do these things, take the time to read the Macintosh System
Software User’s Guide. It provides a thorough introduction to the basics of working
with Macintosh disks, applications, and files.

The basic steps for installing MagicScroll include:
1) Attaching the MagicScroll USB application device to the USB port of your computer.
2) Confirming or installing a compatible video card or NTSC scan converter video
output to your prompter monitors.
3) Copying the MagicScroll Folder from the USB device to your Applications
folder.
4) Running MagicScroll and configuring the video output for NTSC scrolling.
1. Attach the USB Application device to an available USB port on your computer. This
device contains the application, documentation and acts as the security key. If no key
is connected to your computer, MagicScroll will disable the scrolling engine and you
will be unable to get smooth scrolling on your NTSC output. However, you’ll still be
able to edit and prepare scripts for later use.
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If you already have other USB devices plugged filling up your available USB ports,
you may need to obtain a USB Hub. A USB hub is a device which provides up to 4
additional USB ports for your Macintosh.
2. Install a compatible NTSC video card, attach an NTSC scan converter to your
Powerbook/MacBook Pro, or use the built-in S-Video output on your Powerbook/
MacBook Pro (see your Macintosh owners manual or 3rd party video card manual).
To get NTSC or S-Video out of the MacBook Pro, you may need the “Apple DVI to
Video Adapter Kit” part number M9267G/A. If no NTSC device is attached you will
be limited to scrolling on your Main Mac screen.
3. If you haven’t already, turn on your Macintosh.
4. Locate the USB device - MagicScroll - in the Finder, double-click it to open its
directory window. Drag the “MagicScroll Folder” to your Applications folder on your
computer.
6. Boot MagicScroll by double clicking the application icon in the MagicScroll folder
on your computer. Note: the “MagicScroll Folder” will remain on the USB device.
Do NOT launch MagicScroll from the USB device - launch it from the folder you copied to your Applications Folder.
Select the “Video Output” sub-item under the Preferences item under the File menu.
Drag the “Scroll” icon to the video card that you intend to use for scrolling. If you
place the “Scroll” icon on your “main” monitor (the one with the menu across the
top), then you won’t scroll to an external monitor. However, you will be able to scroll
on your Mac monitor for rehearsal and script prep.
New in Ver. 4!

This dialog box also allows you to configure other scrolling features such as the
size of the NTSC Preview window. You can also flip the NTSC output monitor horizontally or vertically. For more information, please see chapter 3, page 22 - Video
Output preferences.
8. If you encountered any problems with installing MagicScroll then re-read the
installation procedures and check the “Troubleshooting” section of this manual. If
these efforts fail to get everything up and running, then give us a call at 415-6265283.
Configuring the “Displays” panel in System Preferences.
Although configuring MagicScroll for NTSC output is as simple as dragging the
scroll icon to the NTSC monitor, the following section provides more detailed information on configuring your monitors with the Displays setting.
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The following instructions describe how to adjust your “Displays” preferences in the
System Preferences. Please refer to your Macintosh manual for more detailed information about setting the status of monitors.
Open “System Preferences” located in the Apple Menu in the upper left of your screen.
Choose “Displays” from the “Hardware” section of your preferences.
The “Displays” panel appears in each of your attached monitors.
If you have more than one video card installed and active, a button called “Arrange”
will appear. Press “Arrange” in order to properly position your monitors.
If you’re using a PowerBook or MacBook, we recommend DIS-abling “Mirror
Displays.” (Mirror displays puts the same image in ALL your attached monitors.)
Normally, you would drag each monitor icon until its position corresponds to the
location of the actual monitor. However, since the MagicScroll monitor is generally
used only for MagicScroll, we’ve found that placing it at either the top-right or lowerleft corners works best. This helps keep your cursor from disappearing off the edge
of your main monitor. Avoid placing it at the lower right corner, as MagicScroll and
other programs tile new windows in such a way as to sometimes cause them to overlap into the MagicScroll monitor.
The “Main” Monitor contains the standard Macintosh menu bar and desktop and is
identified by a tiny Menu Bar across the top. You’ll use it as your “base of operations”
-- while using a NON main monitor for your video output scrolling.
If you need to change Main monitors (i.e. if the NTSC/Output monitor has the tiny
menu bar), then drag the tiny menu bar from the current monitor icon (still using the
Monitors CDEV) and place it onto the one you want as your main monitor.
Choose a display resolution for each of your attached monitors. In the case of
PowerBooks or MacBooks, you will most likely choose “640x480 NTSC” for the resolution of the OUTPUT monitor... NOT your main monitor (laptop screen.)
Close “Displays.”
If you have not yet configured MagicScroll for video output, choose the “Video
Output” option under the preferences menu item and follow the previous configuration instructions.
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Icons & Tools

Boot MagicScroll by double clicking the program icon. The program
will boot, displaying the MagicScroll logo on the “Output” (NTSC)
video monitor. The operator’s screen, or the “Main” monitor will
display a new “Untitled” window and the MagicScroll Control Panel.
Almost every feature of MagicScroll can be accessed through the
Prompter Control Panel window. This window is moveable but not
resizeable or closeable. The panel contains a combination of icons,
switches and the MagicScroll slider icon. Of course, clicking an icon
will activate a particular function.
The switches are activated by simply clicking them, which toggles
them on and off. If you hold the mouse over a button, you will see a
small label describing what that button does. If you click a modifier
key (Option key, Shift key, Control key), the label will change to reflect
what the button does with those modifier keys held down.
The MagicScroll
Control Panel

The Font Icon

The Font icon allows for quick changes between different font sizes
and styles. Unlike previous versions of MagicScroll, you may now mix
different fonts and font sizes throughout your document.
The Font Icon

When using the Font icon to alter the appearance of your text, you
must first highlight the text to be altered by selecting it. If you want
to change the font for the entire document you must first “Select All”
from the Edit menu. Alternatively, you can change the font styles of
the entire document by holding down the option key while selecting
Font, Size, Style or Color from the menus at the top.
To change the size of a font, simply click the Font icon and select the
desired font size. If you select “Other”, you may specify a point size
for your videotext.
To change the font in a document, hold down the Option key while
clicking the Font icon, and all of your available fonts will appear.
Select the font you’d like to use.
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To change a FontSet, hold down the Command key while clicking the
Font icon.
The font and size choices are also available in the menubar across the
top of the operator’s screen. The FontSets menu is available under the
Edit menu.
By holding down the Shift key while clicking the Fonts icon, you can
choose the line spacing you want to use for your entire document. You
can choose from single, 1-1/2, or double spacing.
You can highlight words or sections of your documents/scripts with
underlines, italics, bold or patterns. Styles are available through the
Font icon by using the Shift key.
Simply select the text to be highlighted, hold down the Shift key, click
the Font icon, and select the type of highlighting you want. You can
also set the style of selected text through the Style menu across the top
of the menubar or by using the corresponding Command key combinations:
		
		
		

Command-B for Bold
Command-I for Italics
Command-U for Underline

FontSets

It may be helpful to create FontSets, which are style sheets that include
a font, size, and margins that you can apply to a document or selected
text quickly. FontSets are created in the Edit menu.
To create FontSets, choose Edit Fontsets from the Edit menu. The window that appears shows you a list of the current FontSets.
Create a new FontSet by clicking the New button at the bottom of the
window. Click the Font popup menu and select the font that you want.
10
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The FontSets Window

All of the fonts that are installed in your system will appear in this
popup menu. MagicScroll automatically enters the name of the font
in the “Name of Font Set” field.
Now select a size for your new FontSet. Click the Size popup menu
and select the point size that you want. You may also select “Other...”
and indicate a specific point size for the font. Again, MagicScroll places the size into the “Name of Font Set” field, next to the font name.
Then choose the desired justification. If you want specific margins,
select the checkbox labeled “Use Ruler Settings”, which will use the
current document’s margin settings.
Although MagicScroll automatically names the FontSet for convenience, you may choose to give it another name by typing directly into
the “Name of FontSet...” field. For example, you may want to call it the
“Outdoor Font” or perhaps “The CEO’s Favorite.”
After confirming the name of your new FontSet, click the “Add to List”
button.
Repeat this procedure to create as many FontSets as you desire. If
11
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you want to delete a FontSet, select it from the scrolling window on the
right and then click the Delete button. When you’re done, click OK.
Your newly created FontSets will appear on the Edit menu and on the
Font Icon while holding down the Command key. Simply select the
desired FontSet and any text you’ve selected will then change to the
font, size, justification and margins of that FontSet. If you want to
apply the FontSet to the entire document, hold the Option key down
while you select the FontSet from the menu.
You may find that you want to adjust or change a current FontSet. Bring
up the FontSet creation window by choosing Edit FontSets... from the
Edit menu.
Instead of clicking the New button, click the FontSet that you want to
modify in the scrolling window to the right to select it. The specifications for this FontSet will then appear under the corresponding popup
menus.
Adjust the FontSet by altering the Font, Size, Justification, or Margins.
See “Creating New FontSets” if you’re not sure how to do this.
After making your changes, you may want to re-name your font set by
typing in the “Name of FontSet...” field. Then either click OK, or “Add
to List”. If you click OK now, the window will close and the adjusted
FontSet will replace the previous one under the FontSet icon. If you
click “Add to List”, MagicScroll puts a new FontSet at the end of the
current list and allows you to continue editing your FontSets.
If you are unhappy with your changes, click the Cancel button to close
the window
To delete a FontSet, bring up the FontSet creation window by choosing
“Edit FontSets” from the Edit menu. Click the FontSet that you want to
delete in the scrolling window to the right. The specifications for that
FontSet will then appear under the corresponding popup menus. Now
12
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click the Delete button. The FontSet will be deleted from the list. If
you change your mind, click the Cancel button and any changes or
deletions you’ve made will not be saved.
The Find and Find/Replace Icon

Clicking this icon brings up the Find and Replace window. You can
also open the Find and Replace window by selecting “Find & Replace”
from the Edit menu or by using Command-F.

Find & Replace Icon

To use the Find and Replace window, enter the word or words to
search for into the “Search for” field. Either activate or de-activate the
Match Partial and Case Sensitive checkboxes. Then click the Find
button or press the Return key. The find function always searches
forward from the point of your cursor. When the search reaches the
end of your document, you will be asked if you want to continue the
search from the beginning of your script. When you are done you
may either close the Find and Replace window or leave the window
open and click in an open document/script window.
Note that if the Match Partial checkbox is not activated, the Find feature will only return exact matches of the word you are searching for.
For example, if you want to find the word “test” included within the
word “testing”, you will need to activate the Match Partial checkbox.
Find and Replace allows for quick changes to elements of your document. Enter the text you want to find in the “Search for” field. Then
enter the new replacement text into
the “Replace with” field. Activate the
Match Partial and/or Case Sensitive
checkboxes if desired. Now either
click the Find button and begin to
selectively replace text, or click the
Replace All button. When searching selectively, you must click the
Replace button each time you want
to replace text.
13
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If you click the Replace All button, MagicScroll will change every
instance of matching text it finds throughout your document and then
inform you as to how many changes were made.
You may also search for and replace certain “invisible” characters by
putting a caret (^=shift-6) in front of the letter “P” for paragraph
returns, or in front of “T” for tabs.
The Bookmarks Icon

The Bookmarks feature allows you to set a bookmark at a given point
in the document. By setting bookmarks you can quickly move from one
section of your document/script to another with the click of the mouse.
Bookmarks are saved with your script.
There are twenty bookmarks available in MagicScroll. To set a bookmark at a specific point in your script, place the insertion point or
select a word or phrase at the point in your script where you want to
place the bookmark.
Next, hold the Command key down, click the Bookmarks icon and
select the number of the bookmark you want to set.
The Bookmark Icon

You can also use keyboard commands to set bookmarks. To set marks
1 through 10 use “Command-Option-#”, with “#” being the number
of the bookmark that you want to set. (Bookmark 10 is set by using
Command-Option-0) For marks 11 through 20, use “Control-Option#”, with “#” being the number of the bookmark +10 that you want to
set. Also, you can set a bookmark by choosing Set Bookmark from the
Utility menu.
The Create Bookmark dialog box will appear, asking you to name the
bookmark. If text is selected in your document, then the first 20 letters
of the selection will appear as the default name. If no text is selected,
then the previous name of the bookmark will appear as the default
14
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name. If the mark has not been named before, and no text is selected,
then the default name will be “Bookmark #”. If you want to name it
something other than what comes up, just type the new name into the
Bookmark Name field.
Now click OK or press the Return key. If you change your mind about
setting a bookmark, click Cancel.
MagicScroll puts a Bookmark icon in the Sidebar of your script
to help identify the location and number of bookmarks. See the
“Sidebar” section on page 17 for more information on the sidebar.
You can also set an “Instant” bookmark that bypasses the “Name this
bookmark” dialogue by holding down the Shift key in addition to the
other keys required to set a bookmark. For example, first place your
cursor where you want the bookmark, and then hit the Shift-OptionCommand-4 to instantly set bookmark #4.
You can quickly go to a pre-set bookmark in one of four ways. Simply
click the Bookmark icon and select the bookmark you want to go to,
or choose “Go to Bookmark” from the Utility menu. Or you can use
the keyboard equivalent of “Command-#” for marks 1-10 or “Control#” for marks 11-20. These keyboard commands can be used while
scrolling, allowing you to jump quickly to any marked place in your
script without exiting scroll mode. Also, in the Script Queue window
you can go to any bookmark in any script by clicking the bookmark
pop-up menu.
(See page 20 for more info on the Script Queue window)

To delete all of your bookmarks, hold the Option key down while
clicking the Bookmark icon. A dialogue will ask you if you really want
to do this. The only way to delete an individual bookmark is to re-set
it with a different location and/or a different name.
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The Scroller Icon

New in Ver. 5

In Version 5, you must
use the ESC (Escape) key
to exit scroll mode.

The Scroller icon activates the forward and backward scrolling of
your teleprompter script. This scrolling action works differently than
standard Macintosh scrolling windows because it activates the smooth
scrolling engine within MagicScroll. In order to get smooth scrolling on
your NTSC output monitor you must use this icon-- not the Macintosh
window scrolling arrows at the top and bottom of a scrolling window.
Of course, you can still use the window scroll arrows to get around your
document/script-- but text will not scroll smoothly.
To scroll, simply click the Scroller icon or press the Command-G keys.
This initializes the NTSC monitor to your current place in the script
and activates the smooth scrolling engine. It also activates the on
screen Preview window, so you can see exactly what’s going out to your
prompter monitors. If you do not have a compatible NTSC video card
installed, you can still see the Preview window by selecting your internal (main) screen as your scrolling monitor.

The Scroller Icon

Now, using your mouse or trackball, move the cursor up to make the
script scroll forward and down to scroll the script backward. To stop
scrolling , press the ESC (escape) key. You can pause the scrolling by
pressing the Return key. Press the Return key again to resume scrolling.
The “Preview” window can be permanently left open and placed in a
convenient position on your screen. From the Window menu, choose
Show Preview Window. The size of the preview window can be set by
selecting Preferences (Video Output submenu) from the File menu.
Important Note: You will notice that the direction that you move the
mouse and the direction that the script moves may seem backward
from what you’re used to with Macintosh scrolling windows. The reason for this is a throwback from the early prompters when a mechanical rheostat would actually move the paper script forward and backward underneath a B&W video camera. Moving the rheostat forward
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(or pushing it up) would move the script forward while moving it
backward (down) would physically move the paper script backward.
We designed the MagicScroll slider to emulate mechanical teleprompters.
The Sidebar

Each open script window has a sidebar along the left side of the window. This sidebar contains tools and references to help the prompter
operator manipulate and access the script. In the sidebar you’ll find
the Pointer, Paperclips, Bookmark Indicators and Line Numbers.
The pointer sets a reference point for the talent and the operator while
scrolling. It is displayed on the NTSC screen and can be moved up
or down by just clicking and dragging it. You can change the shape
of the pointer or turn it off by holding down the Command key
while clicking it. You can also change the pointer display by selecting
Preferences (Video Output submenu) from the MagicScroll menu.
Paperclips mark places in your script to allow quick access or referral.
They are similar to Bookmarks except that you can’t give them names
and you can only go to them in sequence.
To place a paperclip while you are NOT scrolling, simply click the
Paperclip icon at the top of the sidebar and drag it to a place within
the sidebar next to the text you want to mark. You’ll notice that the
paperclip is numbered. The first paperclip you place will be #1.
Additional paperclips will be numbered sequentially as you place
them. To place a paperclip WHILE SCROLLING, simply press the
space bar. When you stop scrolling, your paperclips will appear in the
sidebar.
The Sidebar, including:
Paperclip, Bookmark,
Pointer and line numbers.

You can go to paperclips WHILE SCROLLING, or while NOT scrolling. To go to a paperclip, press OPTION-TAB or choose “Go To Next
Paperclip” from the Utility menu. This will cycle you through the
paperclips sequentially. To cycle backwards through paperclips, hit
17
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the OPTION-SHIFT-TAB keys.
You can clear all of your paperclips by choosing Clear Paperclips from
the Utility menu.
The sidebar also indicates any bookmarks you’ve set. When you go to
a bookmark, MagicScroll places the desired bookmark just beneath the
Pointer.
You can show the line numbers of your document in the sidebar by
choosing “Show Line Numbers” from the Window menu or by entering
Command-Option-L from the keyboard. You can instantly go to any
line number by choosing “Go to Line” from the Window menu, or by
entering Command-L from the keyboard.
Line numbers can be printed with your document so that other people
on the set will have a script for reference. Before printing, be sure to
show the line numbers. Then, select Preferences (General submenu)
from the File menu. Activate the Print Line Numbers checkbox, and
click OK. Remember, if you make changes to your script, or if you
change the Font or Size, your line numbers may change.

The Timer/Stopwatch

To show the Timer window, select “Show Timer Window” from the Window
menu.

The Timer Window:
Start/Stop & Reset

The timer is activated while scrolling by pressing the “T” key. To stop or
pause timing, press the “T” key again. Exiting scroll mode by clicking the
mouse or pressing the Esc key also stops the timer.
You can control the timer while you are not scrolling by clicking the green
arrow (red stop sign) to start (stop) the timer, or clicking the blue arrow to
reset the timer.
Selecting Command-T, clicking on the time in the timer window, or clicking
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the arrow next to the ART field in the Script Queue window will place the
time into the Actual Running Time (ART) field of the Script Queue window for the currently active document/script. For more information about
the Script queue, please see page 20.
Other Toolbar Controls

At the bottom of the prompter control window is a set of toggle switches
for activating and de-activating different features. Simply clicking the icon
will toggle the switch from on to off and vice-versa.
The Loops switch allows you to cycle your script continuously between
Bookmark #1 and Bookmark #2 (See Bookmarks). During scrolling, when
you get to Bookmark #2, you will be automatically returned to Bookmark
#1. It’s important to place Bookmark #1 before Bookmark #2 for this feature to work properly. Because the Loop feature and the Linking feature
are mutually exclusive, only ONE of these can be active at a time. The
Loop function is not document-specific, so if you switch from one script
window to another, the Loop feature will remain activated.

The Loops, Blanking
and Linking
buttons.

The Blanking switch turns the output to the NTSC monitor on and off,
sending “black” to the monitor when in the “ON” position. As a failsafe
mechanism, when you click the Scroller icon, MagicScroll automatically
turns the Blanking switch off. When you enter “Scroll mode” your output
will automatically be activated, and conversely, when you exit scrolling, the
output will return to “black.” This switch does not have a corresponding
menu item.
The Linking switch activates the linking feature of the Script Queue window. When Linking is OFF, a single script/file will scroll until it gets to the
end of the file, and then it will stop. When Linking is ON, scripts will scroll
directly from one file to another without having to stop scrolling, bring up
a new window, and start scrolling again.
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The Script Queue Window

Activate the Script Queue feature by choosing “Show Script Queue” from the
Window menu. Script Queue gives you control over the scrolling order of your
different scripts/files. Any open document will appear in the Script Queue
window, with newly opened documents appearing at the end of the list. You
can re-order this list by clicking a file name and dragging it up or down to a
new place in the queue. The current working document is shown in bold letters.
At the far left of each file name is a checkmark that can be toggled on/off by
clicking it. A checkmark next to a file name indicates that the script will be
included in the queue while scrolling with the Linking switch turned “On.” To
remove, or bypass, a script from the queue, turn the checkmark off.
To the left of each file name is a pop-up menu beneath the “>>” column that
allows you to access any bookmark within a script. Simply click the pop-up
menu and select the desired bookmark. MagicScroll will automatically bring
up the selected script and go to the indicated bookmark.
To the right of each file name is an indicator giving an Estimated Running
Time (ERT) and an Actual Running Time (ART). The ERT is based on
the current CPS (Characters Per Second) set in the “ERT pace” field of the
Preferences (General submenu) item under the File menu.
The Script Queue
Window

You can set the Actual Running Time by first timing a script using the timer,
and then clicking the gray arrow to the right of the ART field. The time displayed on the timer will appear in the ART field for that script. Command-T
will also transfer the time from the timer to the ART field.
At the bottom of the window is
a line indicating total running
times for the scripts in the queue,
including only those scripts

which have a checkmark.
A small disc icon next to “Name”,
indicates whether the “Remember Files in Script Queue” preferences option
has been activated. When it is active, the next time you launch MagicScroll,
the files in your cue will automatically be opened.
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Menus and Windows

The menu bar in MagicScroll consists of the standard “MagicScroll”,
“File” and “Edit” menus and additional ones called “Font,” “Size,”
“Style,” “Color,” “Utility” and “Window.” Most, but not all, of the functions can also be accessed through the Prompter Control window and
the corresponding icons or buttons. You should know how to Open a
file and be able to navigate around your hard drive to find the file you
want.

The MagicScroll menu...

Most of the menu options here are standard options for all applications.
Preferences:
The Preferences submenus allow you to set various attributes of
MagicScroll.
General Preferences…

The MagicScroll Menu

The MagicScroll General Preferences dialog box allows you to set various MagicScroll attributes such as the current ERT settings, Toolbar
orientation, and various printing attributes.
When the “Remember Files in Script Queue” checkbox is activated,
MagicScroll will save an alias to all of the currently open files in the
Script Queue. The next time you start up MagicScroll, the files in the
script queue will be opened automatically. The appearance of a small
disc icon in the Script Queue window reminds you that this feature is
activated.
The “Arrange Toolbar” popup menu allows you to arrange the toolbar
21
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so it is displayed either vertically (default) or horizontally.
The “ERT” for files in the script queue is estimated by
multiplying the length of the file by the “ERT Pace”, set
in the ERT Pace field. By default, the ERT pace is 17.2
characters per second, which is the average speed of
most readers.
The “Print Page Numbers” option and the “Print Line
Numbers” option will add page numbers and line
numbers to your scripts when you print them out on
a printer.
General Preferences

Preferences >> Video Output...
The Video Output Preferences dialog box allows you to set various
attributes of the NTSC output display.
The top region of this dialog box allows you to specify on a multiplemonitor Macintosh which monitor will be used for NTSC output. You
should select the monitor that is being viewed by the
talent. If the monitor selected is not the main monitor
(the monitor with the menu bar), the monitor will be
blacked out and the scrolling text will be immediately
displayed.

General Preferences
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The “Scroller Sync” checkbox specifies that the NTSC
output display should be synchronized with your editing. If this checkbox is activated, editing changes you
make in the script will show up immediately on the
NTSC output monitor. If it’s de-selected, any changes
you make while editing will not appear on the Output
monitors until you either enter Scroll mode, or hit
“Command-D” to force the screen to update. This setting is overridden by the “Blanking” toolbar item, which can cause the
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NTSC output display to be blacked out when not in scroll mode.
The “Inverse Video” checkbox changes the NTSC output to black letters on a white background, instead of white letters on black.
The “Flip Horizontal” and “Flip Vertical” checkboxes allow you to flip
the NTSC output display on the horizontal or vertical axis. These
options are useful if your prompter monitors do not support hardware
flipping for use with a prompter mirror. These settings will not affect
the NTSC Preview window; the image in the NTSC Preview window
will be oriented correctly during scrolling.
The “Pointer” popup menu allows you to select which pointer icon (if
any) will appear on the teleprompter display.
The Align NTSC Area popup menu allows you to set how you want
your text displayed on the output/teleprompter window.
Centered: Centers your text in the middle of the screen.
Size to Fit: Uses your text margins to fit the text left-to-right
on the output monitor.
Actual Size: Aligns your text at the top/left of the output
screen and uses the actual size of your text to fit on the screen.
We’ve found that “Actual Size” is the best for most situations.
You can also select “No NTSC Display” to turn off NTSC display.
The “Preview Window” popup menu allows you to set the size of the
Preview Window as a factor of the NTSC display. Your options are Full
size, Half size or Quarter size.
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The File menu...

New: (Command N)
Opens a new untitled window. You can either type in new text or paste
in portions of another file.
Open... (Command O)
Opens either a MagicScroll document or an ASCII text file.
You may also open files from the Mac’s Finder by dragging the file(s)
over the MagicScroll application icon. The maximum number of open
files is only limited by the amount of RAM allocated to MagicScroll.
Recent Files:
MagicScroll remembers your last ten documents that you’ve had open.
Close: (Command W)

The File Menu

Closes a window. MagicScroll will ask if you want to save changes
before closing, which helps to keep you from erasing valuable modifications accidentally.
Save: (Command S)
Updates the file you are working on with the latest changes, by saving
text changes, paperclips and bookmarks. You can always tell if you
have already Saved the most current version of your script, because
Save will be gray instead of black.
Save As...
Allows you to create a new file name for the current document.
Particularly useful if you wish to save different versions of the same
document.
Save A Copy As...
This allows you to save a copy of the current document. It is different
than “Save As...” because it doesn’t change the name or location of the
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file you’re working with, it simply and quickly allows you to make a
safety backup of an open document on your hard drive. When selected, MagicScroll will automatically name your backup “Filename copy”
in the Save dialogue window. You can type in a different name if you
choose to.
Revert File:
This allows you to revert to your last saved version of a script/file.
Any changes you made since the last change will be discarded.
Page Set Up...
Allows you to choose the correct parameters for your printer. Since
most teleprompter files utilize large fonts, a helpful MagicScroll trick
is to set the “Size” or “Reduction” setting to a number between 3050%. This keeps your document’s image/margins/appearance in tact,
while reducing it so that it prints on less pages.
Print... (Command P)
Takes you through the standard print dialogue for your printer.
Quit: (Command Q)
Enables you to exit MagicScroll and return to the Finder/Desktop of
the Macintosh.
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The Edit Menu

Undo/Redo: (Command Z)
If you try a change of font style or edit some text and find it is not to
your liking this function allows you to undo the change immediately.
Cut: (Command X)
Highlight the block of text desired and Cut will move it into your
Clipboard.
Copy: (Command C)
The Edit Menu

Copies highlighted text into the Clipboard.
Paste: (Command V)
Pastes whatever text you’ve either Copied or Cut into the clipboard to
the current insertion point in your document.
Clear:
Essentially a delete function. It eliminates selected text but does not
put it into the clipboard for pasting in later.
Select All: (Command A)
By highlighting this command, you select all the text in the current
active window. If you want to change the font, size or FontSet of the
entire script, you can either Select All, or alternatively, hold down the
Option Key while selecting the text style to be applied.
Find & Replace... (Command F)
Not only will this function allow you to find a particular word, but it
will also replace that word with whatever you so designate. This feature
can also be accessed through the Find icon in the Prompter Control
window or by using the keyboard equivalent of “Command-F.” See the
section on Find & Replace (page 13).
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Edit FontSets:
This brings up the FontSet creation window which allows you to create additional FontSets for use with MagicScroll. For more information on how to create and use FontSets, see the section on the Fonts
icon (page 9).
FontSets:
These are like style sheets that can be applied to a document. They
include a particular Font, Size, Margins and Justification.
The Font Menu:

MagicScroll works with any fonts you have installed on your Mac.
These can be Truetype, bitmapped, or ATM compatible Postscript
fonts. To change the font of a document, just drag down to the one
you’d like.

The Font Menu

If you want to change the font of the entire document to the same
font, hold down the Option key while selecting the font. This will
apply the same font to the entire document.
The Size Menu:

To change the size of a font, select the desired size from the Font
menu. If you select “Other” you may specify a specific point size for
your videotext.
If you want to change the font size of the entire document to the same
font, hold down the Option key while selecting the size. This will
apply the same font size to the entire document.

The Size Menu

You can also bump up by one point the size of the current selection
(or the entire document when used with the Option Key) by selecting
“Increase Font Size” You can decrease the size by one point by selecting “Decrease Font Size.”
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The Style Menu:

There are six different styles available for highlighting or emphasizing
words or phrases in your script. Simply highlight the desired text and
select Plain, Bold, Italic, Underline, Outline, Shadow or Pattern from
this menu. Holding the Shift key while clicking the Fonts icon will also
bring up the Styles menu.
Spacing :
This allows you to apply different line spacing to your entire document.
You can choose from Single, 1-1/2, or Double spacing. You can also
access this feature by holding down the Option key while clicking the
Font icon.
Justification:
You can justify your text so that it aligns either to the left edge, right
edge or in the center of your document.
Tab Width…
The “Style” menu

You can change the tab width used for all tabs in your document. By
default, tabs are 1/2 inch wide. There is no way to mix tab lengths
within a document.
The Color Menu:

This menu lets you apply color to text that you’ve selected. Simply
choose one of the pre-defined colors, or select “Other...” to define a
color using the Mac’s color pickers. Of course, you’ll require color
prompter monitors for this feature to work properly.

The Color Menu
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The Utility Menu

Set Bookmark:
(Command-option-# for 1-10)
		
(Control-option-# for 11-20)
There are twenty bookmarks available in MagicScroll. To set a bookmark at a specific point in your script, place the insertion point or
select a word or phrase at the point in your script where you want to
place the bookmark.
Next, hold the Command key down, click the Bookmarks icon and
select the number of the bookmark you want to set.
You can also use keyboard commands to set bookmarks. To set
marks 1 through 10 use “Command-Option-#”, with “#” being the
number of the bookmark that you want to set. (Bookmark 10 is set by
using Command-Option-0) For marks 11 through 20, use “ControlOption-#”, with “#” being the number of the bookmark +10 that you
want to set. Also, you can set a bookmark by choosing Set Bookmark
from the Utility menu.

The “Utility” menu

The Create Bookmark dialog box will appear, asking you to name
the bookmark. If text is selected in your document, then the first 20
letters of the selection will appear as the default name. If no text is
selected, then the previous name of the bookmark will appear as the
default name. If the mark has not been named before, and no text is
selected, then the default name will be “Bookmark #”. If you want to
name it something other than what comes up, just type the new name
into the Bookmark Name field.
Now click OK or press the Return key. If you change your mind about
setting a bookmark, click Cancel.
MagicScroll puts a Bookmark icon in the Sidebar of your script to
help identify the location and number of bookmarks. See the Sidebar
section on page 17 for more information on the sidebar.
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Go To Bookmark:		
(Command-# for 1-10)
				
(Control-# for 2-20)
You can quickly go to a pre-set bookmark in one of four ways. Simply
click the Bookmark icon and select the bookmark you want to go to,
or choose “Go to Bookmark” from the Utility menu. Or you can use the
keyboard equivalent of “Command-#” for marks 1-10 or “Control-#” for
marks 11-20. These keyboard commands can be used while scrolling,
allowing you to jump quickly to any marked place in your script without exiting scroll mode. Also, in the Script Queue window you can go
to any bookmark in any script by clicking the bookmark pop-up menu.
(See page 20 for more info on the Script Queue window)
To delete all of your bookmarks, hold the Option key down while clicking the Bookmark icon. A dialogue will ask you if you really want to do
this. The only way to delete an individual bookmark is to re-set it with
a different location and/or a different name.
Go to Next Paperclip: (Command-Tab)
Paperclips mark places in your script to allow quick access or referral. They are similar to Bookmarks except that you can’t give them
names and you can only go to them in sequence. See the section on
the Sidebar in the “Icons and Tools” Chapter, page 17, for a complete
description of the use of paperclips.
Clear Paperclips:
This clears (deletes) all of the current document’s paperclips. You can
clear individual paperclips by dragging them off of the sidebar and
releasing the mouse.
Copy timer to ART: (Command-T)
This places the time displayed in the Timer into the current document’s
Actual Running Time (ART) field in the Script Queue window.
Reset Timer:
This sets the timer to 00:00.0.
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The Window Menu

The Window menu lets you quickly move to any open file/script by
selecting the one you want. It also gives you control over some of
MagicScroll’s program windows and other features.
Show Preview Window:
If you have “torn off ” the NTSC Preview window and placed it somewhere on your screen, this command will allow you to close the window. To bring the window back, you will need to re-drag the window
to a place on your screen.
Show Script Queue Window:
This either displays or hides the Script Queue window, which is used
for file/script linking while scrolling. See page 20, for a complete
description on how to use the Script Queue window.
Show Timer window:
This either displays or hides the timer window, which is used for timing a script.
Go Into Scroll Mode: (Command-G)
The Window Menu

This initializes the NTSC monitor to your current place in the script
and activates the smooth scrolling engine. It also activates the on
screen NTSC window, so you can see exactly what’s going out to your
prompter monitors. You can then use your mouse to scroll forward
and backwards. For a complete description of how to scroll, see the
Scroller Icon section in the “Icons and Tools” chapter, page 16
NTSC Display Update: (Command D)
This initializes the NTSC output monitor on command.
This is helpful for quickly displaying last minute script changes without having to click the MagicScroll slider. If you have “Scroller Sync
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On”, the NTSC screen will automatically update any changes you make
to the script. There is sometimes a short delay before the NTSC screen
updates.
Show Invisibles:
This allows you to see where tabs and paragraph returns are placed in
your script These will only show up on the Mac’s/Operator’s screen and
will not appear on the NTSC output. You can also search for and replace
tabs and paragraph returns by using Find & Replace (see page 13).
Show Line Numbers: (Command-option-L)
When activated, this shows the line numbers of your script in the sidebar of the document.
Go To Line Number... (Command-L)
A dialogue box will appear asking you what line number you’d like to
go to. Click OK and your script will jump to the line number indicated.
If you select the name of a window below the Goto menu item, that
window is brought frontmost.
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Keyboard Shortcuts

Here’s a handy reference for all the keyboard commands and shortcuts in MagicScroll. Of
course, many of these items are activated through Menus and Icons. However, as you become
more comfortable with the features in MagicScroll, you’ll find that using keyboard commands
will increase your productivity and speed.
Scroll Mode Keyboard Shortcuts

The following keys perform various functions while in scroll mode.
Spacebar

Set paperclip. This sets a paperclip at the line where the prompt arrow points in the script.

Option + Tab

Go to next paperclip. This immediately moves the teleprompter script to the next paperclip
location.

Option + Shift + Tab Go to previous paperclip. This immediately moves the teleprompter script to the previous
paperclip location.
Command + [1..0]

Goto Bookmark 1 through 10

Control + [1..0]

Goto Bookmark 11 through 20

T

Start/Stop timer from running.

Option + T

Reset timer.

Escape

Exits scroll mode

Return

Hitting it once pauses scrolling -- hitting it again begins scrolling at the pre-pause pace.

The following keys perform various actions while in normal (non-scroll) mode.
Command + N

New Document

Command + O

Open Document

Command + W

Close Document

Command + S

Save Document

Command + P

Print Document

Command + Q

Quit Application

Command + Z

Undo/Redo edit operation

Command + X

Cut selected text

Command + C

Copy selected text

Command + V

Paste selected text

Command + A

Select all

Command + F

Find & Replace

Option + Font menu item Set entire text (not just selected text) to specified font.
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Shortcuts while NOT scrolling, continued:
Option + Size menu item Set entire text (not just selected text) to specified size.
Command + Sidebar Pointer

Change the style of the on-screen pointer, or turn it off.

Command + ]

Increase font size of selection

Command + [

Decrease font size of selection

Command + Option + ]

Increase font size of entire document (not just selected text)

Command + Option + [

Decrease font size of entire document (not just selected text)

Command + B (I) (U) Set to bold, italic, or underlined text
Command + Scroll Icon

Lets you choose the size of your Preview scroll window.

Command + T

Copy Timer to ART of current document

Command + G

Go Into Scroll Mode

Command + D

Update NTSC Display

Command + L

Go To Line

Command + Option + L

Show/Hide Line Numbers

Page Up / Page Down Scroll Document up/down one page
Command + Up Arrow

Scroll Document up one page (same as above)

Command + Down Arrow Scroll Document down one page (same as above)
Home Key

Scroll Document to top

End Key

Scroll Document to end

Command + Option + Up Scroll Document to top (same as above)
Command + Option + Down
Option + Tab

Scroll Document to end (same as above)

Go To Next Paperclip in current document

Option + Shift + Tab Go To Previous Paperclip in current document
Command + [1..0]

Goto Bookmark 1 through 10

Control + [1..0]

Goto Bookmark 11 through 20

Option + Command + [1..0]

Set Bookmark 1 through 10

Option + Control + [1..0] Set Bookmark 11 through 20
Shift + Option + Command + [1..0] Set Bookmark 1 through 10 without prompting for the bookmark name.
(The default name will be used automatically.)
Shift + Option + Control + [1..0] Set Bookmark 11 through 20 without prompting for the bookmark name.
(The default name will be used automatically.)
Shift + Set Bookmark menu item: Set bookmark 1 through 20 without prompting for the bookmark name.
(Same as above.)
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Sample Prompting Session

If you’ve read this manual up to this point, then you should be familiar with all of the commands, functions, and tools in MagicScroll.
Now let’s put them together and run through a sample prompting session step-by-step.

Boot MagicScroll
and Open a File

First, boot MagicScroll by double-clicking the MagicScroll icon from
the finder. You will see the Prompter Control panel. Select New from
the File menu to open a new “Untitled” window. You could start entering text in the new window, but let’s say that you’ve already done the
script in another program and that you saved it as text in that program. Choose open from the File menu, navigate to the script you
want and choose Open.

Adjust your
Windows

The new window will appear with the script in it. Now, if you like,
reposition the Prompter Control window to a position on your screen
that is most comfortable and out of the way of the script windows.

Select a Font
and resize your
script.

Next, since you opened an ASCII file and not a MagicScroll file, you’ll
probably need to change the font and size of the text to something
that is readable by your talent on the NTSC monitor. Do this by clicking the Font Menu while holding down the Option key and select
the desired font. Then choose a large point size (48 or larger) from
the Size menu while holding the Option key down. (The Option key
applies your change to the entire document, not just selected text).

Do some script
prep.

Now, if you have a little time before you have to prompt, you can do a
little prep to help speed the production along. First, proofread your
script by scrolling it for yourself by entering scroll mode and viewing your text in the Preview window. This way you’ll see how the text
appears to the talent. If a word is too long for the line and needs to
be hyphenated, or if there is a typing error, you’ll be able to catch it
before the talent does. As you’re scrolling, you can use the paperclips
by pressing the spacebar to mark places to come back to after reading
through the script. Next, go through and set some bookmarks that
correspond to key parts of the script.
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Roll It!

Now you’re ready to roll. Go to the start of your script, or another starting point. Then click once on the MagicScroll Scroll icon and start
prompting.
When you’re done scrolling, click the mouse button again to exit scrolling. You may want to customize the feel of MagicScroll at this point by
changing the pointer by holding the Command key down while clicking
the pointer arrow.

Make quick
changes.

Save your
changes!
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You will almost certainly need to make changes to your script. To do
this, be sure that you are not scrolling. Make your changes by selecting, deleting and typing text as necessary. You may find it helpful to
change to a smaller size font, which will allow you to see more of your
script at a time. This can be particularly helpful if you’re making many
changes.
After making your changes, be sure to Save your document. If you have
time, you may want to make a backup by choosing “Save a copy as...”
You can quickly return to scrolling by clicking on the Scroll icon or typing Command-G.

Prompting tips for Operators

Prompting Tips

This section is a collection of tips and suggestions for teleprompting
in the field and studio. These ideas cover everything from the setup
to the wrap on a video production and don’t limit themselves to the
use of MagicScroll. We hope they’ll prove helpful in improving an
operator’s production and teleprompting skills.
Tips for Location
shooting.

Get introduced to
talent.

Determine who
makes script
changes.

Listen!

When “on location” check for the following;
1) Try to get “clean” electrical power, ideally not on the same circuit as the lighting department. (A blown circuit while in the middle
of a “Save” could prove fatal to your document!)
2) Determine a good place to set up the teleprompter. Take into
consideration the need for electrical power and the ability to see/hear
talent.
3) If you aren’t in the same room as talent, you’ll need to make
arrangements with the sound department to get an audio feed.
4) Find out where you can store extra cases and equipment so
that they’ll be out of the way.
By checking for these things early on, you can save time by
avoiding last minute changes and surprises!
Introduce yourself or have someone introduce you to talent! If you
can’t do this in person, then you may want to do a quick screen/script
that says “Hello, my name is so-and-so and I’m your friendly prompter operator.” Often times, this friendly introduction can help non-professional talent relax when they realize that the prompter screen has a
human element behind it.
Find out who will provide you with official script changes. Often
times on larger productions, many people will attempt to suggest or
make changes to scripts. In these cases, determining whether it’s the
producer, scriptwriter or talent who can designate a particular change
is especially important.
Listening is one of the most important things an operator can do on
a set. By paying close attention to conversations between the director, producer, talent and other crew members, a good operator will
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not only be ready to roll when the time comes, but will also be able to
anticipate script changes, new starting points and other special needs
as they arise.
Let talent set the
pace.

Lead the talent a
little bit.

Build trust.

Use Automatic
Naming of
Bookmarks.

When actually scrolling, the pace of the scroll should be set by the talent, not by the teleprompter operator. If possible, let talent know that
he/she is setting the pace and that you are following their lead.
When scrolling, “lead” the talent a little bit. Instead of keeping the current line that talent is speaking in the middle of the prompter screen,
lead the talent a little bit by keeping the current line in the top 1/3 of
the prompter screen. This way, talent can read ahead and anticipate
what’s coming. Of course, everyone is different and you may find that
some people like it even closer to the top of the screen or perhaps more
towards the middle.
Help make the talent feel comfortable and relaxed by building trust.
You can do this by scrolling accurately and smoothly, by listening and
responding to prompter related requests/questions by talent, and by
feeling comfortable and confident yourself.
Remember that MagicScroll can name bookmarks automatically
based on the selected text when activating the “Set Bookmark” function Conversely, if you don’t have any text selected when choosing “Set
Bookmark”, it will automatically name it based on a previous name (if
you’ve previously named the bookmark).
One of the most powerful tools in MagicScroll is the ability to move
quickly from large type to small type with a single click of the mouse.

Use FontSets for
Easy editing.
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This is particularly helpful when doing on-the-set editing of scripts.
Producers and writers often use the prompter screen as a visual reference for changing copy when small script changes are suddenly called
for. Unfortunately, the large type (48 point or higher) tends to lead to
“tunnel vision” in the editing process. The result is that a small word
change to the script that’s visible might not work in context with the
words around it.

Prompting Tips

In order to facilitate successful changes
by someone looking over your shoulder
or into the prompter monitor, quickly
change to a smaller font size (18-24
point) that gives them the bigger picture of the script. You may even want to
experiment with different fonts and sizes
to see what looks better in the smaller
format. Then create a FontSet in that
font and size and name it something like
“Easy Edit.”

Use Find & Replace
to “clean up” scripts.

Photocopy the next
page...!

Sometimes, when importing ASCII files
created in other word processors (particularly DOS versions), you’ll find that
there are paragraph returns at the end
of each line. These may affect the way
words appear on screen as, ideally, you
just want paragraph returns at the end of paragraphs. By using the
Find & Replace feature to look for paragraph markers (Shift-6-P), you
can quickly go through your script and change unwanted markers
into spaces and keep or add paragraph returns at the end of paragraphs.
Duplicate the “Tips for Talent” sheet on the next page and keep copies
handy for non-professional talent. You may want to provide a copy for
the director so that he/she can choose to give it to talent.
Welcome to the world of teleprompting!
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Tips for Talent!
There are a few secrets to using the teleprompter and making it work for you, (instead of
the other way around.)
Picture a friend or colleague behind the prompter mirror. You will be looking directly into
the lens and will ‘connect’ with your audience.
Read the text from the middle of the screen. If you like to read ahead, then read from the
top 1/3 of the screen and let your prompter operator know that’s your preference. Ask
him/her to place the pointer at that place on the screen. The prompter operator will scroll
the words on the screen as you read. His goal is to keep the line you are reading as close to
the pointer as possible. The words will scroll by at whatever speed you read them. YOU are
in control of the scroll speed. If you have any doubts about this... try it by stopping and
speeding up during a rehearsal.
Concentrate on your message, not the words. Pause normally! Stop at periods. Remember
it’s all news to your audience. They don’t know you’ve rehearsed it over and over.
The goal is to make it look like you’re not reading. To avoid PROMPTER PANIC, try blinking occasionally, turning your head, ...smiling?... pretend you’re talking to real people...
The Director is your friend. He will try to make your job as easy as possible. When the
Director says “Action”, take a deep breath to relax, wait one or two seconds, then begin.
Until the Director stops you, YOU ARE IN CONTROL.
Singers know that your vocal cords are the first part of your body to dehydrate. Therefore,
drink lots of liquids. You may find it helpful to have a glass of room-temperature water
within arms reach.
Three more things.... RELAX... RELAX... RELAX....
Maintain your energy level until the Director says ‘CUT’. When you finish speaking your
piece you’ll probably want to look towards the director or camera person, but try to avoid
this by continuing to look into the prompter. This will allow the editors time to make
his/her cut.
Don’t forget... this is supposed to be (and can be) FUN!!!
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Troubleshooting

If you’re having problems with the installation or operation of
MagicScroll, be sure to review the relevant section of this manual.
This section will attempt to locate common problems encountered by
operators and engineers. If you are unable to resolve your problem
with this manual, then call Magic Teleprompting, Inc. at (415) 6265283 for support.
Problem:
Every time the Mac
boots, the cursor isn’t
visible and I have
to move the mouse
around to find it.
Problem:
You click the Find button in the Find and
Replace dialog box
and all you hear is a
beep.
Problem:
The Script starts to
jump around while
scrolling.
Problem:
Loops Function and
Linking Function
won’t work at the
same time.

This problem occurs because the NTSC monitor, or output monitor
is designated as the Main (menu) monitor. Any startup screen you
use will also display on the NTSC monitor. To change this, select the
“Displays” option in the System Preferences, select the “Arrange” button, then drag the white menu line to the monitor that you want as
the Startup monitor.

The beep indicates that it cannot find the word you’re searching for. If
you are sure that the word is in your script somewhere try activating
the “Match Partial” checkbox and you may have more success.

This may be happening because the “Script Loop” feature is on. It
may be looping between two bookmarks in your document. Check
the placement of your bookmarks or turn the Loops feature off.

By design, Loops will not work while Linking is on, and vice-versa.
This functionality serves as a failsafe mechanism in case you forget to
turn Loops Off while you’re in the middle of scrolling several scripts.
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Glossary of terms

Alert box: Dialog box informing you of a problem, an incorrect value, or other condition where the
application cannot proceed.
Application: Program that performs a specific task, such as graphics, accounting, or teleprompting.
MagicScroll is an example of an application.
ASCII: American Standard Code for Information Interchange. A collection of 128 alphanumeric characters and symbols whose internal computer representation is standardized. For example, the ASCII
code for the letter “A” is 65 and the ASCII code for the letter “a” is 97.
Blackout: a stage term for turning off all stage and audience lighting in an auditorium. The purpose
is to darken the hall so as to show films or videos or for special effects. Turning “Blanking” on in
MagicScroll creates a Blackout to the prompter monitors.
Character: Single letter, numeral, punctuation mark, or symbol as part of a typeface.
Character Set: Set of letters, punctuation marks, and other symbols available in a particular typeface.
Clipboard: Area of memory (or disk) used as temporary storage to support cut, copy, and paste
operations. See cut, copy, and paste.
Copy: Noun: Generic name for a publication’s text. Verb: Place the currently selected object onto the
clipboard without removing it from the screen. See cut and paste.
Cut: Place the currently selected object onto the clipboard and remove it from the screen. See copy
and paste.
Desk accessory: Utility program on the Macintosh. Examples of Macintosh desk accessories are the
Calculator, Note Pad, Key Caps, and Chooser.
Desktop: Your working area on the Macintosh screen. This includes the menu bar and the gray area
on the screen. The MagicScroll desktop appears on your screen when you open the MagicScroll application.
Dialog box: Window that appears on a document window to provide command options, inform you
of problems, and so on. In some cases, a dialog box has a title bar that allows you to move the box.
Directory: Pictorial, alphabetical, or chronological list of the contents of a folder or disk or a file that
contains a list of all the names and locations of other files stored on a disk.
Document: File created with a Macintosh application. See file.
Document window: Window displaying a document. You can scroll up or down in a document win-
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dow to display different parts of the document. You can have more than one document window open
at a time, but only one document window can be active.
Drag: Move the mouse, with the button depressed, to move or select an object or to choose a menu
option.
File: Organized, named collection of data. Although files can be stored in all types of memory, most
references to files refer to files on floppy or hard disks. In Macintosh parlance, file is often used synonymously with document.
Floppy disk: Removable magnetic storage medium for computers. Although Macintosh floppy disks
have a hard plastic shell, the disks themselves are Mylar.
Folder: Macintosh subdirectory. A folder can contain documents (files), applications, and other folders. You can use Macintosh folders as you would use actual manila folders, to organize information in
a way that is clear and useful to you. See hierarchical file system.
Font: Complete set of characters in one typeface, size, and style. In Macintosh parlance, font is often
used synonymously with typeface.
FontSet: In MagicScroll, a combination of font, size, justification and margins that define the appearance of text in documents and on the NTSC output monitor.
Hard disk: High-capacity, magnetic storage system. Unlike floppy disks, hard disks are generally not
removable. See floppy disk.
Hierarchical file system: (HFS) File organization system that lets you organize computer files and
applications in nested subdirectories. On the Macintosh, folders, which are analogous to subdirectories, can be nested in other folders. See file and folder.
Icon: Graphic image that represents an object or concept. A screen icon in a mouse-based application
may represent an object such as a document, disk, or application. Clicking that icon allows you to
access it. An icon may also represent a concept, such as a wristwatch for “wait.”
Import documents: Use of the text of other Macintosh documents in MagicScroll using the Open...
command.
Insertion point: Flashing line indicating where the characters you type will appear. The insertion
point is moved by moving the mouse and clicking the I-beam pointer in a new location.
Justify: Set text with uniform left and right margins. To achieve this, extra space may be distributed
between letters and/or words. Right justified and left justified refer to text aligned against the right
and left margin, respectively.
Margin: Blank area from the edge of the page to the edge of the text (not including indents).
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Memory: Computer hardware component used to store information for later retrieval. Memory is
measured in number of bytes rounded to the nearest power of 2. Thus 65,536 bytes of memory is
abbreviated to 64K. (K is metric for 1,000.) See ROM and RAM.
Menu: List of options allowing you to choose the next action you want to take. See menu bar and
menu title.
Menu bar: Horizontal bar at the top of the desktop containing menu titles. See menu bar and menu
title.
Menu title: Name of a menu. Menu titles are listed horizontally on the menu bar on the desktop.
NTSC: Television video signal of 525 lines, 30 frames per second- the U.S. standard for television
broadcast and playback.
Paperclip: In MagicScroll™, markers that can be placed at specific points in the script. They are automatically numbered and can be accessed by cycling through them using the Command-Space keys.
Paste: Place the contents of the clipboard on the active page of your document. You can paste text
and objects. See cut and copy.
Point: Unit of measure of type size.
Pointer: 1) Icon that moves around the screen when you move a mouse. Objects, tools, or commands
can be selected with a pointer.
2) In MagicScroll™, a graphic reference point on the NTSC video screen and NTSC mini window that
talent and operator can use to stay “in sync” while scrolling.
Program: List of instructions that a computer can execute. In Macintosh parlance, program is often
used synonomously with application.
RAM: Random Access Memory. The active, working memory of the computer where your data, the
current program, the operating system, and the screen image reside.
Real Estate: In computer lingo, the area on a computer screen for displaying the output of the computer. A larger screen will have more area to display elements of a program or operating system,
while a smaller screen will have less.
RGB: Abbreviation of Red-Green-Blue. A method of displaying color on a video screen by transmitting the three colors red, green, and blue as separate signals.
ROM: Abbreviation of Read Only Memory. A type of computer memory that retains its information
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when the power is off, and cannot be changed by the user.
Scroll: Move a document or directory in its window so that you can view another part of it. In
MagicScroll, to move the text of a script window forward or backwards using the MagicScroll slider.
Scroll bars: Vertical and horizontal bars on the right and bottom edges of the document window that
allow you to view a document larger than the screen. By clicking or dragging on the scroll bar you can
change your view of the document.
Selection: Noun: Object(s) or text selected by the user to be affected by the next command. Selections
are usually highlighted or marked by outlines. Verb: Highlight text or click an object or group of
objects.
Set: In film or video: the area that is used for the videotaping or filming of a production. In stage: the
scenery constructed for a theatrical performance.
Startup disk: Disk that contains a System Folder and the necessary files to start up the Macintosh.
System folder: Folder containing the System File and the Finder and often other applications and
utilities. A disk should contain only one system folder.
Talent: In a video or film production, the person who speaks and appears on camera.
Type style: Character modifications such as bold, italic, and so on.
Wrap: 1) Automatic continuation of text from one line to the next. making it unnecessary to hit
the Return key at the end of each line. 2) The end of a video or film shoot when the crew is finished
shooting and puts away their equipment. They can then go home, have dinner, go golfing or whatever
they do when they’re not working.
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